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1. INTRODUCTION

Warlords II is an eight player game of conquest and empire. Different worlds
are provided as a stage for your ambitions, and as a test of your capabilities.
In the quest for final victory, you will assemble vast armies, conquer and loot
mighty cities, undertake perilous quests, make and break alliances, and wield

magical artefacts of great power.

This manual is written for the Macintosh. Information on installing and
starting the game can be found in the next section.

We all know that Mac users pride themselves on never having to read
manuals, but if you are having problems, please read Chapter 18 on Trouble-
shooting.

2. GETTING: SIARTED

Warlords Il requires a color Macintosh capable of displaying 256 colors (8 bit),
4 Mb of RAM and running System 7 or greater. Warlords Il needs 2.5 Mb of
memory free to run. You can find out how much memory is free by choosing
the About this Macintosh item from the Apple menu. If there isn't 2.5 Mb free
before running Warlords II, then the program will not be able to run.

If there is between 2.5 Mb and 3 Mb free, then Warlords Il will run, but without
music and with a smaller version of the Strategy Map, in order to conserve
memory.

If there is more than 3 Mb free, then music and the larger Strategy Map will be
available, and the game will also run faster.

(a). ITard Disk Installation

In order to ensure a trouble free installation, you should ensure that no System
Extensions or other programs are running when you install Warlords II. To
temporarily turn off the System Extensions, restart your Mac while holding
down the SHIFT key, until the ‘Extensions Disabled’ message appears.

A typical installation of Warlords Il will take about 8 Mb of Hard Disk space.
The install program will give you an exact figure for your particular installa-
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tion. Please ensure that you have enough space free on your hard disk.

Place the disk labelled Warlords II Disk 1 in your floppy drive, click twice on
the Installer icon, and follow the installation instructions on the screen. Please
read the README file that will be shown on the screen before proceeding with
the installation.

Theinstallation program will suggest a Standard install that is correct for your
computer type. If you wish to customise the installation, the Custom button
lets you select exactly which game elements are installed. Unless you have
particular requirements, choose to proceed with the Standard install.

The installation program will install Quicktime 2.0 and Quicktime Musical
Instruments in your System Folder, unless a later version is already present.
These files are necessary for the game’s music, and startup display to run.
Because of this, your Mac will need to be restarted before running the game for
the first time.

(b). Starting the Game

Open the folder where you have installed Warlords Il and double-click on the
Warlords II icon to start the game.

3. AN OVERVIEW

The mighty events of the recent past. . .

A short time ago, but an immeasurable distance away, the land of Illuria was
finally at peace. After a long and bloody war, it had been united under
brilliant, wise, benevolent and far sighted leadership. The name of this
Supreme Leader, who shall illuminate and at the same time overshadow all of
recorded history is, of course, constantly on your lips.

Despite the dawning of a new golden age, there was still a problem in Illuria
(there always is!). All manner of heroes, knights, generals, admirals and other
military men, valiant warriors all, had contributed to the great victory but
were now, sadly, without vocation. And being, as required by legend, huge
and hearty, ham-fisted and hairy (well... maybe some of the women weren’t
so hairy), they were totally unsuited for a life of peace.
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Did one but require a tribe of Orcs be slaughtered, their skulls artfully
compiled into a fifty foot pyramid... or fresh materials for a heads on pikes
collection... then these were just the men for the job. Sadly though, in these
modern times, such culturally significant skills were no longer required, and
the military men did not fit in.

Nor did they go away! Decomposing carcasses of divers, vivisected monsters
littered castle and countryside, inns and taverns were demolished by their
carousing, and, worst of all, they would not pick up peasants after using them
for target practice.

Every celebratory banquet had to be bigger and better than the previous one.
Not that the luckless guests often got the opportunity to eat... again and again
the cutlery was purloined for the thousandth retelling of great battles and
great deeds... it seemed every hero was personally responsible for the defeat
of the fearsome Jessarton Light Infantry!

Something had to be done. The Great Helmsman called all the Sages of the land
together, and told them that they were to do it. Their alternative, as the Father
of His People casually mentioned, was the demolition of their Temples, the
razing of their Libraries, and the immediate employment of all surviving
Sages in the Royal Sanitary Corps.

Armed with this subtle encouragement, the assembled Sages wrought a
mighty spell. All the heroes, and the other unemployable military types, were
plucked from the land and dumped, en masse, in the new world of Etheria.

Etheria had many lands to conquer, much that was worth fighting over, new
and worthy opponents, and could offer instant and profitable employment to
the newcomers.

That was then, this is now. . .

The new world of Etheria was ripe for exploitation. Vast tracts of land were
populated by quiescent, placid populations, but dreams of empire still burned
in the hearts of some. There were many populated land masses in Etheria, and
surely an enterprising Warlord could build an empire on one of them.

Your mission. . .

Your mission is conquest. Select the land you wish to start with, and select the
forces you will control. Your goal in Warlords II is fiendishly simple; to
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vanquish all opposition to your rule. To do this you will have to control all the
cities in the game. The only way to do this is to take them by storm.

The application of military force is the method of first (and favourite) resort in
Warlords II. Naturally, you will have to pay some attention to economic and
possibly diplomatic considerations but in the end, you’ll have to confront the
armies of your enemies, and defeat them utterly. In Etheria, Might is Right!

Overwhelming force does not mean unsophisticated. There are many cunning
ways of giving your troops an edge in battle. Troops led by heroes and
accompanied by fearsome allies will fight better. Heroes can search ruins or
undertake quests to find the magical items that enhance their leadership in
battle. Flying armies can appear behind enemy lines, and naval forces can take
coastal cities, or transport invasion forces.

Regrettably, the process of bringing your enlightened rule to all will occasion

the demise of all other forces, but this is inevitable. You can’t make an empire
without breaking dynasties.

4. ThHE TUTORIAE

Follow the instructions in Chapter 2 for installing and starting the game. These
tutorial instructions assume that you're running the tutorial on a 640 x 480
screen. If you're running on a 12" monitor, Color Classic, or on some
Powerbooks, the windows that contain the control and stack items might be
in a slightly different place, or somewhat truncated. If you're running the
game on a monitor larger than 14", then the windows are also shifted around
slightly, to make more efficient use of the extra screen area.

(a). Starting the Tutorial

After the intro and title screen, the first screen you see will be the Scenario
Select screen. A list of scenarios is shown in a scroll box. Click on the Tutoria
scenario, and then click on the Use Selected Scenario button.

Since this is a tutorial, you won’t have to select sides or set game options.

As the tutorial starts, the first of a number of help screens built in to the tutorial
appears with some useful information.
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(b). Your First Hero

Your side is the Knights. Click on the turn number message when it appears
to start your turn. On the first turn of every Warlords I game, a hero appears
in your capital. A help screen appears with some info about heroes. Click on
the Done button to make it go away, and then examine the hero dialog. You can
rename your hero by editing the text box containing his or her name. When
you've finished, click on the Hire button.

(c). Producing an Army

After confirming the arrival of your hero, your next job is to order the
production for your city. Another help screen will pop up and explain this
process. When you're ready, click on the Done button to make it goaway, then
examine the production screen.

You only have one army type that you can produce, so click on the army icon.
The army icon will be highlighted, and the Current: line will show that the
army will arrive in one turn (abbreviated as 1t). The details of your army are
shown on the right hand side of the dialog. Click on the Done button when you
have finished.

(d). Selecting Armies for Movement

Once you’ve ordered production of a new army, it’s time to start moving the
ones you already have. The help screen appears to explain how you select an
army, or armies, for movement. Put away the help screen, and examine the
map. On the large map you will see a white castle, with an icon representing
your hero standing on the castle. Move the cursor directly over the hero. It will
change into a circle with a dot in the middle. This indicates that you can select
the army beneath it. Click on the hero icon.

Another help screen appears to explain moving armies, which is what you will
do next. Click when you have finished, and look at the screen. Your hero icon
is surrounded by a moving highlight, indicating that it has been selected for
movement. Looking at the small box at the bottom of the map, you can see the
hero icon displayed again. It is highlighted, indicating that any movement
orders will apply to that army.
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Just to the right is another icon. It is greyed out and has a highlight ring that
is yellow rather than white. As it stands, this army won'’t be affected by any
movement orders you give.

Choose the Stack command from the View menu. This brings up the Stack
Dialog. You can see that your hero has a +2 hero bonus. Hit the Group All
button. Now both armies are highlighted, and will move together. Notice also
that the Light Infantry gets the bonus added to its strength, as it is now
grouped with the Hero. Hit the OK button.

(e). Moving Your Armies

Witha group of armies selected, the cursor will change to a pair of walking feet
as you move it over the map. Click on the road to the left of the castle. Your
group will move along the road to the point where you clicked. Keep clicking
to the left until your group reaches a junction in the road. Take the road leading
to the bottom of the map. At the at the end of this road is a grey castle. This is
your first objective, Click on the road just outside the castle, so that your group
moves there.

(t). Your First Battle

With your army sitting outside the castle, move the cursor over the grey army
inside. It changes into a sword, indicating that you can attack the castle. When
the cursoris a sword shape, hold down the SHIFT key. The cursor chan gesinto
a question mark. Click with mouse button. A sagacious looking adviser will
appear, and advise you that the coming battle will be a walkover. Click on the
Done button. Move the cursor back over the defender and click. The combat
dialog appears, and the results are shown and announced. You should win the
battle.

(g). Your First Victory

When you take a city, you have four options, as explained in the ubiquitous
help screen. Put away the screen, and then click on the Occupy button in the
dialog. You now get to specify more production for your newly conquered
city. Read the help screen and then click on the middle army type (Light
Infantry), to begin producing that.
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(h). What ‘TouDonNext

First, choose the End Turn command from the Game Menu. This will bring you
to Turn 2. The help screen brings up some more advice. We're going to take
some of that advice by searching a ruin. First, look at the Control Window in
the bottom right of the screen. Click on the icon with the large, right facing
arrow. This will move around all of your armies, selecting each of themin turn.
One click should bring you the stack in your newly conquered city containing
your hero, although he won’t be part of the current group. Look in the Info
Window at thebottom of the map. Atthe bottom right of that window isa small
button with the word Group (abbreviated to Grp). Click on that button. That
will group your Hero together with the two Light Infantry armies. They will
all be highlighted.

(If you are using a Mac with a 12" or other small screen, you won’t get the Grp
button. Use the Stack command from the View menu, or the Group Stack
command from the Orders menu, instead).

Then move the group to the ruin that is just to the north-west of your new city.
Its the straggly lump of stones that looks, well, ruined. When you get there, a
help screen tells how to search ruins, and what you can expect to receive. Click
on the help screen, and then choose Search from the Hero menu.

If you meet monsters, they might fight you, or join your side. If you find a sage,
take the money. After searching the ruin, move back to your city, and then end
the turn.

(i). Dealing with Computer Players

Since this is a tutorial, your opponent will be a bit of a patsy. That doesn’t mean
that you can take too many chances. Always garrison your cities with at least
three armies, and try to attack with a large stack. This may mean sitting around
for a little while you build up your armies.

There are a few ruins on the tutorial map. Choose the Ruins command from the
View menu to see which sites are unexplored, and take your hero exploring.
Make sure you take some armies along with him when you do.

When you are ready to attack the computer’s cities, use the adviser to check
things out first.
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(j). Messing About in Boats

There two cities not on the centre island. This is not a problem. When you have
your attacking group assembled, just select it, and click on the road just outside
the castle you are trying toreach. The computer will work outa path, and move
your group to the island by boat. All you have to do is keep moving the group
along its path, by using the walking feet button in the Control Window in the
bottom right of the screen.

(k). Winning

If you hold most of the cities, your opponent will offer to surrender. If you
accept the offer, you have won. If you don't, you will have to take every enemy
city on the board to win. Good luck!

5. STARTING A GAME

(a). Selecting a Scenario

The first screen you see after the game titles is the Scenario Select screen. From
here you can select a New Scenario to play or choose to play a Random Map
game. To select a scenario to play, click on its name in the scroll box. The
display to right shows a description, the number of Cities and Ruins, and the
number of players, in the scenario.

To play the selected scenario, hit the Use Selected Scenario button.
To play a Random Map game, hit the Use Random Map button.
To load a Save Game, use the Open command from the File Menu.

(b). Random Map

Warlords II has the capacity to produce a virtually infinite number of worlds
through the Random Map function. Clicking on the Use Random Map button
brings up the map specification dialog.

Using the sliders, the parameters for the amount of Water, Hills and Moun-
tains, and Forest terrain types in the new map can be varied, as can the number
of cities. Clicking on the word Random to the right of the sliders, or moving
the sliders to the Random position, will produce a random result for that
variable.
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Production in a scenario is set by the scenario designer. In a random map you
have one element of choice. Certain powerful army types are usually only
found as allies of heroes in the game. However, you can choose to have some
cities start a random game able to produce these types. Clicking on the Cities
Can Produce Allies check box will change this setting.

In a Random Map game, you can also choose the Terrain Type, Army Type,
City Set and Shield Set that will be used, through the pop-up menus. Warlords
II Mac will provide two choices for each of these parameters. The default
choices in these menus are the standard Army, City and Shield sets. Other SSG
products may add more.

(c). Choosing Sides

After a scenario has been loaded, ora Random Map game created, you will see
the Game Setup screen. This comes in two flavours, the Fewer Choices screen,
and the More Choices screen.

The first time you start Warlords I, you will see the Fewer Choices screen. This
allows you to quickly start a single human player game, by selecting a side to
play, the level of your computer opponents and your game options. (Game
options are described in Section 5 (e) below). Fig 5.1 shows the screen.

To start a game, make your choices, and hit the Begin Game button.

If you want to make more detailed choices of your game options, or start a
game with more than one human player, hit the More Choices button. This
button takes you to the more detailed version of the Game Setup screen. Fig 5.2
shows the screen.

This screen lists the eight sides in the game, along with icons displaying who
is controlling them.

Each side can be controlled by a Human, or a Knight, Lord or Warlord
computer player, or can be not playing at all. The computer Warlords are the
fiercest of opponents, and it is recommended that you begin by playing against
Knights.

To change control of a side, click on the word describing who controls it. It will
scroll to a new setting, and the icon beside it will change. The estimated
difficulty factor appears on the right hand side of the screen.
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(d). Setup Side

As well as the level of each computer opponent, you may also choose to play
against a particular computer personality. Click on the computer opponent
icon to bring up Setup Side screen. See fig 5.3

First, as an indulgence to your own personality, you may rename the side.
- Naturally, there is nothing to stop you giving computer players morale
sapping names like Attila le Duck, while reserving something suitably glori-
ous for yourself.

Under the side name, you are shown a list of leaders suitable for the level of
opponent you have selected. Each leader has a Name, and a description of his

Side Setup

ulr'u'i'tE_Elularue?

|
— _I—I

Standard Warlord E's
Attila the Hun
Margaret the Ferrous | |
lan the Infamous

Nikolas the Nefarious
Steven the Insidious
Hand the Hammer
Roger the Unrepentant [

- | .y
= (Nescription

Fig 5.3 The Setup Side Screen
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Attitude, which may give some clues as to how he will perform. To find out
more about these leaders, you will have to face them in combat. If you'd like
the added uncertainty of not knowing who you're fighting against, then hit the
Select Random Characters button on the game setup screen, and your oppo-
nents will be chosen for you.

You don’t have to select a personality for computer players. If you don’t the
computer will provide a standard opponent for Knight, Lord and Warlord
levels.

Human player sides can also be renamed, just by clicking on the human face
icon.

(e). Game Options

There are a number of game options in Warlords II. A pop-up menu at the top
the screen lets you select between three different levels of difficulty, Beginner,
Intermediate and Advanced. The difficulty rating is displayed below this. To
getinto the game quickly, you can just select a difficulty level, and hit the Begin
Game button.

If you wish to examine all the game options, hit the Edit Options button.

If you have a particular set of options that you always use, you can create your
own option. Setall the game options you wish to use, then edit the option name
and hit the New button. Fig 5.4 shows an option set, ‘Gregor’s Choice’ having
been defined. You can also highlight an option and use the Delete button to
remove it.

When finished, hit the Done button. This option set will now show up in the
pop-up menu on the Game Options screen.

When you have made all your choices, hit the Begin Game button to start.

(f). EAETificinl Intelligence

The Al routines in Warlords II are a huge improvement over those in the
original game. The Warlord level players are difficult to beat because we made
them smarter, not because they can produce more than you or because they
have other hidden bonuses. They do not get extra heroes, combat bonuses or
lower production costs because they are computer players.
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Fig 5.4 The Game Options Screen

(g). I am the Greatest

The I am the Greatest button lays down a challenge to the rest of the world. It
automatically chooses Warlords as your opponents, although naturally you
may still change this. Whoever you finally fight, you may rest assured that the
computer players have heard, and will respond, to your boast.

(h). Play by E-Mail with Powertalk

Powertalk is a new technology. It's new for Apple, new for games, and we
freely admit that its new for us. It promises to make Play By E-Mail games so
very easy to use that we've decided to include it in the release version.
However, we simply can’t guarantee that everything will work smoothly.
Please read the Read Me file for the latest information on this.

Please read your Powertalk documentation, and set up your Powertalk
software before trying to use the Powertalk section of Warlords 1.

If you have Powertalk installed on your system, then the E-mail game
checkbox will be active. Click on this and then click on the Set Addresses
button, to set up an E-mail game.

You will see a Powertalk browser, like the one in fig 5.5. The figure shows two
addresses which are defined in a Personal Catalog. To assign an address to a
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Fig 5.5 The Powertalk Browser

player, highlight the address in the catalog, and then click on the player
number you wish to choose.
When you have assigned Powertalk addresses to all the players taking part by

E-mail, hit the Done button. Games can have mixed complements of computer
and E-mail players. Games do not have to be set up by Player One.

Oncea Powertalk game has been started, then whenever an E-mail player ends
a turn, then the game is automatically saved and transmitted by Powertalk to
the next E-mail player. The file will appear in the Powertalk mailbox. To
continue the game, just double-click on the file.
Unfortunately, we cannot delete the Powertalk files after they have been used,
so you will have to perform this task manually.

(i). Other Play by E-Mail Games

If you want to play E-Mail games using a mechanism other than Powertalk,
just save the game at the start of the next human player’s turn, and send the file
on. The screen will be blanked out while the player turn message is on the
screen, so no advantage can accrue to either side.

0. PLAYING THE GAME

The screen in Warlords Il is divided into five areas. These are the Menu Bar, the
Playing Map, the Strategic Map, the Action Palette and the Info Area/Stack
Palette.
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Fig 6.1 The Playing Map

(a). Using the Playing Map

The playing map is where you move your armies and make them fight. The
map shows a close up of the world chosen for the scenario. See fig 6.1.

As you move the cursor over the map, it changes in response to different
conditions or key-presses. These changes give you feedback as to what is
happening, and what commands you can issue.

The possible cursors are explained below.

R’ This is the standard cursor. It appears in dialogs and over the menu Bar.
It is also used to deselect an army.

fz) This is the army selection cursor. It appears over armies that you own.
Clicking on a stack will select a group for movement, and bring up the
Stack Palette. See Chapter 7 for more details.

' This is the city cursor. It appears over cities. Clicking on the city is the
same as issuing the Production command from the View menu, and takes
you straight to the production dialog. Clicking over enemy cities takes
you to the city info screen for that city.
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This is the combat cursor. It appears over enemy cities and stacks that
you can attack. Clicking will initiate combat.

' This is peace cursor. If the diplomacy option is on, you may be prohib-
ited by convention from attacking certain forces. The heart shaped
cursor replaces the combat cursor to remind you of your diplomatic
obligations. Since no piece of paper can really stop a Warlord, you can
still attack. However, if you do, you will pay a heavy diplomatic price
for your dastardly actions. See Chapter 14 for details.

This is the land destination cursor. It appears when a group is selected
and the cursor is over land. Clicking on the map sets a destination for the
selected group. See Chapter 7 for more details.

This is the sea destination cursor. It appears when a non flying group is
selected and the cursor is over sea. Clicking on the map sets a destination

for the selected group. See Chapter 7 for more details.

This is scrolling cursor. It appears when you hold down the Option key.
You can then move the map around for as long as the button is down.

This is the path create cursor. Holding down the Command key will
bring up this cursor. Clicking will create a destination and the path to
that destination, but the group will not move along that path. This
allows you to check out the computer’s movement decisions, without
committing yourself.

@ This is the combat adviser cursor. If the Military Adviser option is on,
then when the combat cursor is showing, holding down the shift key will
change that to the adviser cursor. Clicking will then bring up the
military adviser’s estimate of your chances if you commit to combat.

S 3 BB

fg Thisis the ruin cursor. It appears over ruins and temples and brings up
the ruins dialog.

Balloon Help

Holding down the Control key and moving the cursor brings up Balloon Help
information on just about any part of the game. You can get info on armies,
cities, terrain, ruins, signposts, icons and buttons, towers and both maps to get
information or reminders. You can also get help or reminder screens inside
most dialogs. Just try it out to see how useful the system really is.
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The Shift Key

Sometimes the cursor won'’t be in the right condition for a command that you
wish to issue. For instance, if you have an army selected, and you move the
mouse over another friendly army, the land destination cursor will appear.
You may decide that you really want to select the second group instead.
Holding down the shift key will cause the cursor to change to the army
selection cursor, and you will then be able to select the new group.

The Command Key
The Command key brings up the path create cursor.

s (b). Usin g the
f Strategic Map

This map shows the entire land at a reduced
scale. Cities are shown by the shield of their
owner, or grey shieldsif neutral. Asthe cursor
moves over the Strategic Map, it changes to a

magnifying glass.

Clicking on the Strategic Map will scroll the
Playing Map to the square selected on the
Strategic Map.

See fig 6.2.

Fig 6.2 The Strategic Map

(c). Using the Action Palette

The Action Palette contains a number of buttons which help you manipulate
the map and your forces. The scroll pad moves the Playing Map. The center
button in the scroll pad will centre the screen on the current group.

On small monitors, a smaller palette is used, with only five buttons.
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Fig 6.3 The Action Palette

The diplomacy button reports diplomatic proposals, and clicking on it will
take you to the Diplomacy screen. See fig 6.3.

The movement control buttons are explained in Chapter 7. The shortcuts are
explained in Chapter 16.

(d). The Info Area

The info area appears when there is no group currently selected. It shows the
number of cities that you own, your wealth, yourincome for this turnand your
current upkeep. See fig 6.4.

Fig 6.4 The Info Area

(e). The Stack Palette

The Stack Palette appears whenever a group is selected, and is explained in
Chapter 7.

7. MOVEMENT

The most important actions in the game are moving armies and making them
fight. There are a number of ways to move armies in Etheria (or wherever). You
probably won’t need to use all of them, but will instead choose a few
techniques which suit your style of play.
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(a). Groups and Stacks

A group consists either of a single army, or two or more armies that you have
explicitly combined. Armies that you have grouped always move and attack
together, until you explicitly separate them, or they die.

To select a group, just click on the group’s army icon on the Playing Map. A
highlight willappear around the selected group. As you move the cursoraway
from the army, it changes into a pair of legs, indicating that you can now give
a destination to the selected group, just by clicking on the map.

A stack consists of all the armies in a single square, regardless of how they are
grouped. For instance, all armies in a square will defend together, regardless
of their grouping. Units move and attack as groups, and defend as stacks. A
maximum of eight armies may occupy each square on the map, although
groups of armies may pass through each other in excess of this limit during
movement.

(b). The Stack Palette

In the Stack Palette, at the bottom of the map, you are shown the currently
selected group, plus any other groups that are in the same square. The display
looks a little complex, but it has been designed so that you can manipulate
groups and stacks without having to call up dialogs or clutter the screen. See

fig 7.1.

OO0 CAE

QRO CE

Fig 7.1 The Stack Palette
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The current group is shown by a green tick under the left-most army of the
group. If there is more than one army in the group, they are displayed
immediately to the right of the first army, and all armies in the group have
background circles of the same color.

Units in the same square, but not in the current group, will have their icons
greyed out. They themselves might belong to different groups, and thus might
have more than one background circle color.

There are three operations that you can perform on groups; changing the
current group, adding to the current group, and subtracting from the current
group.

To change the current group, just click on the red cross icon of the group that
you wish to make current.

To add to the current group, click on the greyed out icon of the army you wish
to add. The army will be highlighted, and its background circle will change

color to that of the current group.

To remove an army from the current group, click on its icon. The army will be
greyed out and placed in a new non-current group of its own.

Sinceall armiesina group are arranged next to each other in the palette, adding
or removing armies may cause armies to move around in the palette. A few
minutes experimentation will illustrate just how the system works.

There is a small button in the bottom right of the Stack Palette. Whenitis green,
clicking on it will ungroup all armies, and place them in single army groups.
When it is red, clicking will merge all armies together into a single group.
The individual movement factors of each army are shown under their icons.
The group move, which is the lowest move factor of the armies in the current
group, is shown above the group button.

[fevery army in the current group is capable of flying, a small pair of wings will
appear in the top right of the Stack Palette. If the current group gets a woods
movement bonus, then a tree is shown, a small hill for a hills bonus, a

combination wood and hill if the current group is eligible for both bonuses, or
a boat if the group is using naval movement.
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(c). Moving Around

To be moved, a group must be selected by clicking on it, and only the currently
selected group will be moved. A glance at the Stack Palette before selecting a
destination will ensure that the right armies get the orders.

Once a group is selected you can use a number of techniques to move them.
Most techniques involve the creation of a path. This is shown on the Playing
Map as a line of hollow dots.

This path will be remembered from turn to turn, although it may change if the
computer finds a more efficient route in subsequent turns. You can easily get
the group to continue along the path in following turns. Dots with a cross
through them indicate those portions of the path that you cannot reach this
turn.

With the land destination cursor showing, you can click anywhere on the
playing map to establish a destination. The movement routines will find a very
efficient route to the selected destination, and thearmy willimmediately move
along that route.

With the path creation cursor showing, clicking on the map establishes a path,
but the army does not immediately move along the path. A group can be made
to movealong its path by clicking on the walking feeticon in the Action Palette,
as soon as you are happy with its intentions.

The arrow keys, or the numeric keypad keys, orthe Q, W,E, D, C, X, Z,and A
keys will also move thearmy one square at a time and the 5 or S keys will center
the screen on the current army.

Remember the last move can always be undone, provided you haven't
performed another action, or haven’t exposed part of a hidden map, or
conducted a combat.

(d). Deselecting Groups

ﬁ A group may be deselected by clicking on the deselect icon, a flag
with a cross, in the Action Palette. Shortcut = Escape key.
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(e).

Movement Control

As your empire grows, you will have greater numbers of armies in far flung
parts of the world. To keep track of these forces we strongly recommend that
you use the movement control commands provided in the Action Palette.
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(i). Move Group

This button is only active if the current group has a path defined.
Clicking on the button will cause the group to move along that path.
Shortcut = END key or Command-M.

(ii). Next Group

This command takes you to the next group available for movement,
and selects it. You can loop through all of your armies as often as you
like, giving orders until none are left capable of moving. Shortcut =
Return or Enter key or Command-N.

(iii). Leave Group

This command will leave the current group out of the Next Group
loop until the next turn. Itis useful when a group still has movement
points left, but is already positioned where you want it. When a
group runs out of movement points, or does not have enough points
to move, the Leave Group command is automatically issued for that
group. Shortcut = Tab key or Command-L.

(iv). Defend

This command takes a group out of the Next Group loop for this and
subsequent turns, until it is selected again by clicking on the group’s
icon on the map. This is very useful for garrison troops, who will not
be moving, and who only clutter up the Next Group loop.

If a group is outside of a city or ruin, and it is given a defend order,
and it remains stationary for one full turn, then at the start of its next
turn, it will be considered to be encamped. The group’s icon is
replaced by a small tower, and it receives a +1 bonus in defence.
Shortcut = Command-;.



(v). Show Army Destination

This command toggles the main map between showing the
currently selected group and its destination. Shortcut = Spacebar
key.

(vi). Cancel Path

This command cancels the current path. Shortcut = Del, Back-
space or Clear key.

(vii). Mouse and Keyboard Info

This command brings up a series of screens which summarise all
important mouse and cursor commands, along with shortcuts and
key modifiers.

(f). Undoing Movement

Any of the above movement commands are undoable, using the Undo
command from the Edit menu. If your last command moved a group on the
map, then this movement is also undoable. However, movement cannot be
undone after a combat, or if the move has exposed part of a hidden map.
Shortcut = Command-Z.

8. MOVEMENT RULES

(a). Movement Points

In order for an army to move in Warlords II it must have enough movement
points (MPs) to get to its new location. Movement points might be better
described as “potential for movement”. In other words, they indicate how far
an army can move in one turn. An army of heavy infantry has few movement
points; cavalry has a lot of movement points, since it is on horseback.

Different types of armies will have different movement points.

Different types of terrain will use up different amounts of movement points.
As a basic rule, each terrain type has a fixed cost for all armies. Some armies
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Fig 8.1 The Army Bonus Screen

are then given a bonus, in the form of lower MP costs for certain terrain, and
can transmit that bonus to other armies that they are grouped with.

For example, it is easier for elves to move through a forest. If you have a group
containing an elf, then all armies in the group will pay the lower MP costs in
a forest, rather than the standard rate.

Since both army types and movement bonuses can vary between scenarios, the
necessary information can be found within the game itself.

The Army Bonus command in the View Menu shows the move and combat
bonus for each army type. If an army gets a movement bonus, this is indicated
by a small icon to the right of the army icon. A tree means a bonus in forests,
a hill means a bonus in hills, wings mean that the army can fly.

The move bonus means thatarmies pay the plains cost for the terrain they have
the bonus for. See fig 8.1.

Each turn an army will regenerate its movement points. If it had any left over
from last turn, a maximum of two MPs may also carry over to the new turn.
The Appendix shows the move values for the different types of armies.

(b). Illegal Moves

A group may never move into any of the following places.
* Any terrain type marked as forbidden for that army type.
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 Off the edge of the map.

* Onto an enemy army, or into an enemy or neutral city. These locations must
be fought over, rather than moved into.

» Onto one or more of your own armies if that would result in more than eight
armies in that location at the end of the group’s move. Groups may move
through their own side’s stacks without worrying about stacking limits. The
Diplomacy option allows you to move through Allied stacks asif they are your
own. See Chapter 14.

(c). Movement in Groups

When armies move, they pay a standard cost for each terrain type entered.
Some armies have movement bonuses in certain terrain. If a group contains an
army with a move bonus, then the entire group pays the lower cost for that

terrain.

A group’s move will stop as soon as one army does not have enough MPs left
to enter the next square, even though some armies may have MPs left. Of
course, you can always divide the group, and continue moving with those
armies so capable.

There are exceptions to this rule. A hero may travel with any army using that
army’s movement cost. Thus a flying army may fly a hero over mountains or
sea. The hero will only be able to fly if all the remaining armies in his group are
capable of flying or he has a magical item enabling his group to fly.

(d). Naval Transport

Warlords Il makes it very easy for armies to use naval transport. Groups can
embark on transport ships atany coastal city, bridge or port. (A portisa coastal
square marked with an anchor symbol). To use the transports, just set a
group’s destination on or over water. The group will move to the embarkation
point and stop, and its icon will be replaced with that of a transport ship. Next
turn, the group will be able to move on the water. Note that the group does not
use a single boat, nor are these boats part of the stack. Instead, each army may
be thought of as hiring, (or commandeering), its own boat.

When a group reaches a disembarkation point, (these are the same as the
embarkation points), the group may disembark by moving onto land. If itdoes
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s0, its move will be stopped, and next turn the group will be able to move
normally on land. Note that this means that armies can only disembark at

coastal cities, bridges or ports.

If a naval group moves onto an enemy city, the group will attack the city as if
it had attacked from land, but this will not end its naval movement. It is
possible for a naval group to continue moving and attacking coastal cities for
as long as it has the MPs to do so.

The movement routines can handle naval movement automatically. If a
group’s route takes it across water, the routines will move the group to the
appropriate embarkation point, cross the water, then disembark and continue
moving on land, all without any need for intervention by the player.

9. ARMIES

(a). Introduction to Armies

Armies play a very large part in Warlords II. Without them you could not take
over cities, or defend yourself from your marauding opponents. There are
three main types of armies; ordinary armies such as infantry and cavalry,
special armies such as dragons and wizards, and heroes.

(b). Stacking

Up to eight armies may be in the same location at the same time. This will be
indicated by the length and location of the army flags. The first four armies in
a stack are indicated by the increasing length of the top flag. A fifth army is
indicated by a short bottom flag, and a short top flag. Thereafter, the sixth,
seventh and eighth armies of the stack are indicated by the increasing length
of the top flag. Thus, stacks with four or less armies have only one flag, those
with five or more have two.

Armies in a group need not be of the same type; for instance you could have
one cavalry, one giant, a dragon and a hero.

32



- Stack (Info

Gregor ©

Fig 9.1 The Stack Info Screen

(c). Stacks and Groups

While up to eight armies may be in a single square, they are not necessarily in
the same group. Check the Stack Palette or use the Stack command from the
View menu to make sure of the composition of a stack. See fig 9.1.

(d). Acquiring Armies

There are twenty eight different army types in Warlords II, and three different
ways of acquiring them; production, alliance and hiring.

All cities in Warlords I start off by being able to build one or more army types.
These can be produced through the production routines. You may also elect
to build a production type, paying a large sum of money for the privilege,
which may then be produced as normal. See Chapter 12.

Alliances are made when a hero searches a ruin, and its guardians decide that
they wish to join him, rather than fight him.

Heroes in Warlords Il are only available for money, apart from your first hero,
who arrives free of charge. Heroes offer themselves from time to time, if you
have the money for their hire. Heroes who are hired will also bring at least one
special creature as an ally. See Chapter 15.
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(e). Disbanding Armies

The Disband command from the Order menu is used for disbanding your
armies and removing them from the game. Use this command when a single
army or a group is selected. It is particularly useful for getting rid of excess
troops, so that you no longer have to pay any upkeep for them. You can
disband an unwanted hero.

10. ATTACKING

(a). Description of Attacking

Attacking is defined as the act of trying to physically destroy an enemy army
(or stack) by moving a group into the same location as the enemy. You cannot
move onto or through an enemy army, you must fight it. If you wish to attack
with every army in a square, they must be in the same group, otherwise your
attack order will only apply to some of the armies present. It's probably a good
idea to check the Stack Palette just before an attack.

Attacking is also the only way of capturing cities. If you attack an enemy city
and all of the enemy armies are destroyed, or none were present, then you will
have captured that city.

If you can attack an adjacent stack or city, the cursor will change to a sword
when you move it over the enemy. Clicking on the enemy will then initiate the

attack.

(b). Strength Points

Each army has a number of strength points. This is an indication of how well
that army fights. The minimum basic combat strength for an army is one, the
maximum is nine. The Stack command from the View menu shows you the
strengths of all armies in a stack. As well as their basic strengths, armies can
be given bonuses in the form of extra strength points for a variety of reasons.
These are shown in brackets after the basic strengths. Obviously, these can
vary throughout the game, depending on what armies are in a stack.
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(c). Combat Bonuses

The path to victory in Warlords II lies in using combat bonuses so that armies
fight at more than their basic strength. There are a number of ways of doing
this. Some add to the basic strength of an army while others are conferred by
other armies in the group.

(i). Individual Bonuses

Searching at a temple will get an army (armies) blessed, adding +1 to
its (their) combat value. See Chapter 13.

Armies can be awarded medals, which permanently add to their base
combat value.

Heroes can reach higher levels of experience, which permanently add
to their base combat value.

Individual bonuses are awarded to some armies when they fight on
certain terrain. Terrain is determined by the terrain in the defender’s
square.

(ii). Stack Bonuses

Units given a defend command can become encamped, gaining a +1
bonus on defence. See Chapter 7.

Stack bonuses are generated by specificarmies, but apply to all armies
that they are stacked with. All special armies generatea +1 stack bonus,
except Dragons, which have a +2. Heroes can generate stack bonuses
by virtue of their strength, and often carry artefacts which give further
bonuses. Defenders in cities also receive a bonus from the city walls.

There is a maximum stack bonus of 5 that can be applied to any stack.

The Stack command in the View Menu will give information about the
strengths and bonuses of armies in a stack. The Army Bonus command
in the View Menu will give info about the combat bonus of each army

type.
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(d). Losing Combat Bonuses

In certain circumstances, bonuses can be lost. Certain armies will negate
bonuses conferred by heroes, or all non-hero bonuses (except city and en-
camped bonus). Siege engines will negate the city defence bonus. Bear this in
mind when you construct your stacks. A stack containing cheap, low strength
armies inflated by lots of combat bonuses looks good only until it loses those
extras.

(e). Brief Description of Combat

When a combat occurs, each side lines up its armies according the order
specified in the Fight Order command of the Order menu. The default is
weakest armies (crossbow fodder) first. The first two armies square off, and
fight till one is killed. The next army on the losing side steps into the breach,
and a new fight starts. Combat always continues until one side is completely
destroyed.

A few important points arise from this. It is very unlikely that the first armies
in a stack will survive any but the most trivial combats. Also, if you lose a
combat, you lose everyone.

The combat system favours quality of army more than it does quantity. Be
warned, however, the lowliest light infantryman is capable of destroying the
fiercest dragon! Just don’t count on it. The bias towards quality is somewhat
reduced if you use the Intense Combat option (see Appendix B for more details).

(f). Attacking Cities

If a city produces one or two armies, its defenders receive a +1 bonus. If a city
is capable of producing three or four armies, the bonus is +2.

When attacking enemy cities, it is necessary to defeat all the enemy troops
within that city. It does not matter which wall of the city you attack. Thus,
although you can only attack with a maximum of eight armies, a city will
defend with all the armies it contains, which is a maximum of thirty two.

This means that the taking of a strongly defended city requires some thought.
The best tactic is to assemble two or three stacks of eight to do the job. The first
stacks will have to wear down the defenders to a point where your best and last
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stack can finish them off without suffering too many casualties. A catapult,
which negates all city defence bonuses may also come in handy.

You may console yourself with the thought that it is simply too expensive to
maintain large garrisons inall cities, and any opponent who tries that will soon
be bankrupt.

(g). Victory in Sieges

After you've attacked and taken a city, you are presented with a dialog
containing four options. In order of increasing severity they are Occupy,
Pillage, Sack and Raze. If you Occupy, then you simply take over the city as is.
If you Pillage, then the city loses the production of its most expensive army,
and you receive money from the process.

If you Sack, then the city loses production of all but the cheapestarmy, and you
receive more money as a result of your depredations. If you Raze the city, then
it is burnt to the ground and cannot be rebuilt. You receive no money for this
dreadful act, but your scorched earth policy may be strategically useful in
denying resources to your enemies. See fig 10.1.

However, pillaging, sacking and especially razing a city will make you
unpopular with your neighbours. This unpopularity will occur whether or not
you are using the diplomacy option, so some discretion in your handling of
conquered cities is advised.
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Fig 10.1 The Castle Victory Screen
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(h). Naval Combat

At sea, all armies on boats fight with a combat strength of four, regardless of
their actual strength, and no bonuses are allowed for any reasons. Flying
armies fight normally against naval groups, and could thus be very lethal
against a navy.

When a naval group attacks a city, it fights as a land group, with all its normal
bonuses.

When armies in a city attack a naval group, which they can do if the naval
group is adjacent, the city stack fights as a navy, with the combat strength of
four and without bonuses. Be aware that in this situation, the Military Adviser
will get his diagnosis wrong.

(i). Combat and Diplomacy

The diplomacy option can impose some restrictions on combat. If you are
adjacent to a city of a neutral or allied power, or a stack of an allied power, then
the cursor will change into a heart, informing you of diplomatic restrictions.

You can always attack a stack or city under diplomatic restriction, simply by
clicking when the cursor is heart shaped, but you will pay a heavy diplomatic
price for your dastardly actions. See Chapter 14.

(j). Veteran Armies

After each combat in which two or more armies on both sides participated and
the winning side was led by a hero, there is a small chance that an army on the
winning side will be recognised as veteran. Heroes and allies are not eligible
for this accolade. If an army is so honoured, a medal will be awarded, and the
unit’s strength will be increased by one. This award can be made a maximum
of four times, for a +4 increase in strength. Veteran armies are indicated by a
small star(s) next to the army icon in the Stack dialog.

(k). How to Win Combats

A full explanation of the combat system is provided in Appendix B. However,
you don’t need to know all these details to play the game. The tips given in this
chapter will explain what you need to know.
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The key to combat in Warlords II is the combat strength bonuses. Careful
application of these makes poor troops strong, and good troops stronger.
However, no stack can be considered unbeatable.

The best strategy is to structure attacking stacks around heroes and special
armies. Heroes can carry the various artefacts that give bonuses, and can also
generate their own bonuses as they increase in experience. Special armies give
a bonus to all armies in a stack, or remove bonuses from enemy stacks. These
are very valuable and should be included whenever possible.

You can now fill out the stack with lesser armies, cheaper and quicker to
produce, who can do the necessary dying but who will fight well because of
the bonuses. You should also consider following your strong stacks with
replacement stacks, containing your favourite crossbow fodder troops. These
stacks do not fight, since they do not have any bonuses, but simply provide
replacements for casualties in the main stack.

As the game goes on your opponents will be able to afford a better class of basic
troops, and you will also have to start producing stronger troop types as the
basis of your stacks.

Once players’ economies are up and running, the best possible stack would
look something like this; a hero, carrying as many artefacts as possible, a
Dragon to give a +2 stack bonus, a Devil to negate enemy non hero bonusesand
an elephant to take -1 off the enemy stack. Round this out with tough armies
that give good movement bonuses. If you are attacking an enemy stack
containing a hero, an Archon, which would negate his bonuses would also be

very useful.

11. MONEY

(a). Income and Expenditure

In Warlords II, you are controlling an empire, and just like a real empire, there
is never enough money. How do you get money? There is basically one
solution; capture cities. You start the game with some gold, but after this,
almost all gold is generated by cities.
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Each city has an income associated with it, which represents trade and taxes.
If you owna city, its income will be added to your tally of gold at the beginning
of every turn. Thus, if you owned three cities generating 20 gp, 25 gp and 28
gp respectively (where gp stands for gold pieces), you would receive 73 gp at
the start of your turn.

When you take an enemy city, you are given the option to pillage or sack the
city. Pillaging and sacking both generate money, but damage the productive
capacity of the city. See Chapter 10. Sages can also reward heroes with money,
as well as information.

Where does the money go? Chiefly the money goes to supporting your troops,
although you must also pay to produce them. It costs half as much to support
anarmy each turn asitdid to produce it; thusif it costs 4 gp to produceanarmy
of heavy infantry, it will cost 2 gp to support it every turn (for more information
on production costs, see Chapter 12). Money may also be spent on building
production for new troop types (very expensive), increasing production and
hiring heroes.

(b). Lack of Money

Lack of money is a very serious problem. This is not often the case early in the
game, butas your empire expands, you may find it has grown too fast! Without
money you cannot build troops; thus you cannot defend your borders when

they become weak.

More importantly, you cannot defend your interior from sudden incursions
by the enemy. If you are in a deficit situation, you must take action immedi-
ately. Disbanding troops will save a lot of money, and is often the only way out.

12. PRODULTION

Production is the training, recruiting and building of armies to prepare them
for battle. Each city has a maximum of four different army types that it can
produce. It can only produce one army at a time.



(a). Producing New Armies

To set production for a city, move the cursor over it. The cursor will turn into
a tower, and clicking will bring up the production dialog. (If an army is
selected for movement, you will have to hold down the Shift key to get the
production cursor, or choose Production from the View menu).

The dialog opens with the new army production screen. If you choose other
functions from this dialog, you can return to this screen by hitting the anvil
button. The map shows the cities you own. Cities not producing have white
shields, cities producing have white shields with a black anvil. The city whose
production is currently being examined has a white anvil with a black border.

The display shows the name of the city, and the current production. Under this
a row of up to four icons, which show the troop types which may be produced
this turn. Clicking on one of these icons brings up the relevant details about
that troop type, and selects it for production. The Stop button cancels the
production order. See fig 12.1.

( innabaria

Fig 12.1 The Army Production Screen
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The strip of icons along the bottom allows access to other production func-
tions.

(b). City Information

The castle icon with a question mark provides a summary of all the attributes
of the city.

(c). Building

The crane icon gives access to three functions. The Rename button allows you
to rename your city (remember, ego is not a dirty word). The Raze button
allows the desperate to raze their own city.

The Build Production icon brings up a dialog which allows you to build a new
army type for the city to produce. Some army types (specials and heroes)
cannot be built, others may cost more than your current treasury contains, and
are greyed out. The valid builds are listed along with the cost of building that
type.

Choosing an army here does not produce it, it just makes it available for
production in that city. A maximum of four army types may be produced by
a city. You cannot build the same type twice, but you may replace any existing
type with a new army.

Position the highlight around the production slot you wish to assign the new
army type to. Be careful not to unwittingly replace an existing army type!

(d). Vectoring

Clicking on the arrows icon brings up the vectoring screen. Vectoring is a
method of allowing to you transfer new production between cities, without
going to the trouble of moving armies between them.

Instead of armies turning up in the city which produced them, they can be
vectored to another of your cities. Vectored armies take the normal time to
produce, and then take an extra two turns to arrive in their destination city. See
fig 12.2.

Thedialog shows you the vectoring arrangements for the city named at the top
of the screen. Its current production is shown, along with any outgoing armies
that are in transit to another city.
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(Crystal Palace

Fig 12.2 The Army Vector Screen

Below that, the Next Turn line shows the incoming armies that are arriving
next turn, and the Turn After line shows what will arrive in two turns time.

A city can be the destination for the production a maximum ot four other cities.

There are two possible actions in the vectoring screen but they both work the
same way. First you select a source, then an action, then a destination.

(i). Vectoring to a New City

First select the city that is the source of the vectoring army by clicking
on the city’s shield on the map in the dialog. Then click on the button
with a single yellow arrow. Then click on the shield of the destination
city on the map. A yellow line will be drawn from the source city to the
destination city, and the vectoring will be in place. If a city cannot be
a destination for this action, i.e. it already has four incoming armies,
then its shield will not be shown on the map.

Note that for this to make sense, the source city must actually be
producing something.

To cancel a vector, select the source city as the destination, i.e. click on
the source city, click on the yellow arrow icon, then click on the same

city.
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(ii). Changing Destinations

As well as being the source of vectored production, a city may at the
same time be the destination of up to four other cities’ production. If
you click on a city in the vectoring dialog, any cities which are
vectoring to the city you are examining are shown in orange, and are
connected to the city by orange lines.

Sometimes it's more convenient to adjust the destination of such
vectoring, rather than four separate sources. Click on the shield of the
city that is receiving the vectoring, click on the icon with the orange
arrows, and click on the shield of the new destination. If a city cannot
be a destination for this action, i.e. it will create more than four
incoming armies at the destination, then it will not be shown on the
map.

That's all there is to it. Just remember that in the vectoring dialog,
orange is incoming and yellow is outgoing. The See All button will
show all vectors, not just those for the current city. It can get confusing,
but it might remind you of arrangements you have forgotten.

13. SEARCHING

(a). Description of Searching

In general, searching is performed by a hero, either on his own or with some
help. Searching is done for a variety of reasons which are described below, but
largely it is done at special locations to find either items, allies, information or
gain some other advantage for that hero.

Searching is not without risk, as malevolent and sometimes powerful crea-
tures guard their treasures. While a hero can search on his own, the more
armies that accompany him, regardless of their strength, the better his chance
of surviving the inevitable combat.

(b). Ruins

Unexplored ruins are always guarded. If a hero defeats the guardians, or
persuades them to join him, he is considered to have also explored the ruin.
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Upon exploration, ruins can yield gold, artefacts or allies, or the hero may
encounter a Sage. The Sage will offer up to three choices. If the hidden map
option is on, the Sage will offer to reveal a small area of the map of your choice.
Or you may ask a Sage for the location of a particular item, or choose to be
rewarded with money. Once a ruin has been explored, it is useless.

(c). Temples

Temples have two functions. All armies, including heroes, may present
themselves at a Temple and receive a blessing. Due to the intensely practical
nature of religion in the land, this blessing is worth +1 in combat value. Other
temples can add their own blessings, each worth +1, but you cannot be blessed
twice by the same temple.

If the Quest option is on, a Hero may be given a chance to take on a quest. See
Chapter 14.

(d). Where to Search

The Ruins command on the View menu brings up a dialog which shows you
all of the ruins and temples on the map. Each ruin is classified as explored or
unexplored. You can also hold down the Control key and move the mouse
over any ruin on the playing map to get a Balloon Help report on its
exploration status.

Some ruins, called Strongholds, are heavily guarded and contain the most
powerful magic items. These are normally shown in the ruins dialog. How-
ever, if the Quest option is on, then these sites will be hidden, and their location
will be revealed only as the reward for a successful quest. See fig 13.1.

(e). Description of Items

Magical artefacts are an important part of Warlords II. They are either found in
ruins or given out by temples as rewards for successful quests. Artefacts can
confer strength or stack bonuses to heroes, allow a stack to fly or improve tax
collection from the wretched peasants.
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Fig 13.1 The Ruins Dialog

14. GAME OPTIONS

Warlords IT has a large number of game options. These allow you to customise
the game exactly to your liking, and enable you to play more complex games
as your knowledge and confidence grow.

(&), Nedtral L itres

Unless you have chosen the Quick Start option (see below) all cities, except the
player capitals start the game as neutrals. Neutral cities can be average, strong
or active.

Normal neutrals have a single defender of the lowest strength that the city can
make. They should be pushovers for any attacking force, especially if led by
a hero.

Strong neutrals still have a single defender, but this is chosen from amongst all
the types that city can build, so some defenders will be strong armies. Strong
neutrals call for a more considered approach to conquest.

Active neutrals can be a real problem. While still only starting with a single
defender, this defender is much more likely to be a strong army. In addition,
if an attack on an active neutral fails, the city will start producing extra
defenders, up to a maximum of four armies. Active neutrals, if not handled
correctly, could seriously disrupt the early days of your empire.

46



(b). Quick Start

The Quick Start option avoids any fuss about neutral cities by dividing up all
cities amongst the players at the start of the game.

(c). The Military Advisor

Even the mightiest Warlord can occasionally benefit from some independent
advice. If the Military Adviser option is on, then when the sword cursor is
poised over an enemy stack, holding down the Shift key will turn the sword
or heart cursor into a question mark.

Clicking will then bring up the adviser’s opinion of the coming combat, which
is usually very accurate.

(d).Hidden Map

If this option is on, then all of the map is hidden, and the only exposed terrain
is a small area around your start castle. The map is only exposed as your troops
move over it. This option is especially useful if you have chosen a Random
Map scenario. Of course, it will also produce a certain amount of doubt in
players’ minds. Who knows what is lurking in the dark bits of the map?

(e). Random Turn Order

Normally the order of player turns follows that of the game start screen. If the
Random Turns option is On, then player order is determined randomly at the
start of each turn. This means that a player could movelastin one turn, and first
in the next turn, effectively getting two moves in a row. This option will put
a little more uncertainty into the minds of Warlords.

(f). View Enemies

If this option is on, then you can hold down the Control key and move the
mouse over an enemy stack to examine it. If it is not chosen, then the only way
to determine the full composition of an enemy stack will be to implement a
reconnaissance in force, and attack the stack.
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(g). View Enemy Cities

If this option is on, then the Cities command in the View menu will allow you
to examine the production info of an enemy city. If it is off, then the Cities
command will only reveal details about your cities.

(h). Intense Combat

If this option is on, combat is more likely to result in heavy casualties to both
sides, and the advantage that strong armies have over weak armies is reduced.

(i). Quests

If this option is on, then heroes searching at temples may be offered a Quest.
Only one hero per side can have a quest at any one time, and the quest lasts
until itis fulfilled, or is impossible to complete. A quest is allocated to a specific
hero and he, or his stack, must perform the actions indicated in the quest.

If you accepta Quest, then the Quest command in the Report menu will remind
you of your obligation. If events render the Quest impossible, then a message
at the start of the turn will announce this.

Yourreward for completing thisarduous task may be a magical item of greater
than usual power, or revealing to you only the location of a ruin containing
such an item. Quests may also be rewarded with allies, or money, especially
if the successful hero seems poor.

(j). Diplomacy

This option is very powerful. If it is off, then all sides are in a state of perpetual
war with each other, and can attack each other without restriction. If it is on,
then a complete diplomatic system regulates the conduct of sides towards
each other.

Under the system, sides can be in one of three states towards each other. These
are Allied, Neutral or Hostile. The Diplomacy command in the Report menu
depicts the diplomatic relationships between all the sides in the game. See fig
14.1.

During the course of the game, sides may send diplomatic messages to each
other. The Diplomatic Action dialog, reached through the Diplomatic Report,
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Fig 14.2 The Diplomatic Action Screen

summarises the diplomatic relationship of your side with each other player.
[t also lists any proposals that they have made to your side, and provides a set

of buttons for your replies, or where you can initiate your own proposals. See
fig 14.2.
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The system works by comparing proposals between sides, and implementing
the most hostile proposal. If one side proposes Alliance, and the other side
proposes Hostility, then Hostility will prevail.

If one side proposes Neutrality, and the other Hostility, then Hostility would
again prevail. If both sides propose Alliance, then that would be implemented.

The system regulates combat between sides. Allied sides should not attack
each other’s armies or cities. Neutral sides should not attack each other’s cities,
but can attack each other’s armies without restriction. If attacks are imple-
mented, in defiance of diplomatic restrictions, then the attack counts as a
declaration of war. Your diplomatic rating will suffer a severe drop, and you
may find other sides also regarding you as an enemy.

If you downgrade an alliance or neutrality by sending a message through the
system, then you only pay a moderate price in terms of your diplomatic rating.

The computer lists all sides in order of their credibility. The side who has been
least treacherous is rated as Statesman; the side who has been most faithless
is rated as Running Dog. This list is relative. All sides will probably have
indulged in a few broken promises; the list simply ranks them each turn.

The computer uses this rating to help it decide whom to ally with, and whom
to attack. If your behaviour is too outrageous, you may find the rest of the
world turning against you.

15.. HEROES (AND HEROINES)

Heroes are such an important part of Warlords II that it is useful to summarise
all their functions in one place.

(a). Inspecting Heroes

The Inspect command in the Hero menu brings up a dialog which summarises
each hero’s status. See fig 15.1.

The dialog shows the hero’s name, the other armies with him and his location
and other information as explained below.
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Fig 15.1 The Hero Status Screen

(i). Battle

A hero can give a stack bonus to other armies stacked with him by
virtue of his strength. If a hero’s strength is between 4 and 6, the bonus
is +1. If it is 7 or 8 the bonus is +2. If his strength is 9, then the bonus is
+3.

Battle items act to increase a hero's strength, and can thus increase the
stack bonus he gives. The Battle figure in the report is the number
added to the hero’s strength by the items he is carrying.

(ii). Command

As well as a stack bonus due to strength, a hero can generate a stack
bonus by carrying artefacts which give a command bonus. A good
example is the Standard, which isissued to the initial hero on each side.
[tis worth a +1 stack bonus to a stack containing a hero who is carrying
it.

(iii). Levels

Heroes in Warlords Il can increase their capabilities by gaining experi-
ence and increasing in levels. Heroes gain the following experience
points: searching a ruin +3, capturing a city +2, defeating an enemy
outside a city +1, defending against attack +1, being blessed +1,
completing a quest +10.
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Fig 15.2 The Hero Display Screen

The Levels command from the Hero menu shows information about
all your heroes, including their current experience points and the
points needed to reach the next level. For each new level, a hero adds
+1 to strength and +2 to movement. See fig 15.2.

(iv). Experience Points
The Hero's current Experience Point total is shown.

(v). Items Being Carried

There are two scroll boxes, one showing items carried, the other, items
on the ground. Clicking on an item will highlight it, and show an
arrow. Clicking on thearrow, or double-clicking on the item, will move
the item from one box to the other.

(b). Standards

Each side gets one Standard along with their first hero at the start of the game.
This standard is +1 command item, but it has another special property. Using
the Plant Flag command from the Hero menu, the standard can be planted in
the ground. Troops can then be vectored to the standard, just as if it were a
castle, with the usual limit of four armies per turn. This means that assault
groups can be assembled exactly where you wish, rather than only at the
nearest castle.
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The hero does not have to stay with the standard once it is planted, but it
wouldn’t be very smart to wander too far away. Stacking limits apply to the
square the standard is planted in, so you can’t have more than four armies with
the standard if it is to receive four armies through the vectoring process.

(¢). Hiring Heroes

After the first hero, there is a small chance in any one turn of a hero presenting
himself for hire, if you have the money available. If you don’t have enough
money, heroes won't show up. Second and subsequent heroes are more
expensive than the first, so be sure to try and keep plenty of cash on hand. If
you own less than half the cities ina game, the maximum number of heroes you
can have is five. If you own more than half, the maximum is six.

(d). Searching and Questing

Searching ruins is the only way to get artefacts. Some scenarios, or random
map games may allow you to produce special armies, butallies gained in ruins
are free, and have no maintenance costs. As soon as you can afford to, a hero
should be set off to explore these places. If the Quest option is on, then a hero
should be delegated to perform one.

16. COMMAND SUMMARY

Most of the commonly used game commands are duplicated as Menu Items,
and also have keyboard equivalents. Some of the less common commands are

only found on the Menu Bar.

(a). The Menu

About Warlords 11

This item reports the version number of the game, credits, SSG addresses and
scenario info.
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(b). The File Menu

New Game
Exits the current game and returns you to the Start Game screen.

Open
Brings up a standard Open Document dialog. You can load scenarios or Mac
or IBM save game files.

Note. While you can load IBM save games, they can only play if your Mac
contains the scenario file that the save game uses, and the Army, City and
Shield sets used in the game. If Warlords Il can’t find these files, then the save

game won't be able to run.

Close
Closes the current game.

Save Game
Saves the current game.

Save As

Brings up a standard Save Game dialog. A pop-up menu at the bottom of the
dialog allows you to save games in Macintosh or Warlords I IBM format. The
IBM version of Warlords Il cannot recognise games saved between turns, and
so the IBM format choice will not be available at this point in the game.

Revert
Reverts to the last Saved Game.

Quit
Exits the current game.
(c). The Edit Menu

Undo
This command will Undo the last action, unless it was a move that exposed

part of a hidden map, or a combat.
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(d). The Order Menu

Group Stack
Group all armies in a stack into a single group.

Ungroup
Ungroup all armies into individual groups.

Move Group
See 7 (e) (i).

Move All Armies
Move all armies along their paths.

Cancel Path
See 7 (e) (vi).

Next Group
See 7 (e) (i1).

Leave Group
See 7 (e) (iii).

Defend
See 7 (e) (iv).

Deselect Group
See 7 (d).

Show Current Army
Scrolls the map and centres on the current army.

Show Army's Shadow
Scrolls the map and centres on the destination shadow of the current army.

Fight Order

This dialog shows all the armies for your side, and the order in which they line
up for combat (see Chapter 10). Normally, you would wish to put the weakest
armies first, and preserve high value armies by putting them last.
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This is the default order. However, advanced players can use this command
to implement their own ideas on combat strategy.

To change the order, click on one army, then click on another to make them
swap positions or use the arrow keys to move the selected army. The reset
button will restore the default setting.

Heroes always go last, unless over mountains or sea, in which case a flying
creature will be the last army, to avoid a hero being stranded by the death of

his flying transport.

Disband Group
This command will disband the currently selected group.

Signpost
If a currently selected army is over a signpost, you can choose the Signpost

command. You will then be able to edit the signpost, and leave a message of
your own for friend and foe alike to read.

Resign

There seem to be two resign options for a human player; Resign Graciously
and Resign Ungraciously. In reality, a player may only resign ungraciously,
burning all his cities to the ground in the process. For a less extreme measure,
just use the settings command to switch an absent human player to computer
control.

(e). The Report Menu

Show Report
Brings up the last report you examined.

Army Report

Shows the number of armies each side has. The map shows the location of each
army or stack.

City Report
Shows the ownership of each city on the map.
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Gold Report
Shows the amount of gold each side possesses.

Production Report
Shows all the armies that you produced this turn.

Winning
The computer totals various factors and then produces a rough guide as to

who is currently winning. This is the subject of much contention in multi
player games. Nobody wants the onerous accolade of winner, since this only

encourages the rest to combine and attack him.
This report is thus very useful if you aren’t winning, and best ignored if you
are.

Diplomacy

This command is active if the Diplomacy Option was chosen. There are two
screens associated with this command. The Diplomatic Report, which comes
up first, shows the current diplomatic state between all sides. Clicking on the
Diplomatic Action button in the bottom left of the screen shows the current
diplomatic state between your side and the others, any diplomatic proposals
you might have received, and allows you to respond to those proposals (see
Chapter 14).

If the Diplomatic Action button is red, then someone has made a negative
proposal to you. If it is green, then a positive proposal has been received.

Quest

Quests are allocated at Temples. Each side can only have one quest active ata
time. This report will show your current quest, if any, and any results you may
have achieved towards the quest’s completion (see Chapter 14).

(f). The Hero Menu

Inspect

The Inspect command shows the location of all your heroes. The hero named
at the top of the dialog is highlighted on the map. Any armies accompanying
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him are also shown, his location is named and his Battle and Command
bonuses, Level and Experience Points are all shown (see Chapter 15).

Plant Flag

Your first hero comes generously equipped with a Standard. This item is
worth a +1 Command bonus and can also be used to rally your armies to your
hero’s side. To do this, the hero must be selected, and not standing in a city,
temple, ruin or at sea and the Plant Flag command chosen (see Chapter 15).

Levels

This brings up a dialog listing all of your heroes, their levels, current Experi-
ence Points, points needed to reach the next level and Strength and Movement
points (see Chapter 15).

Search

This is one of the most useful, and rewarding commands in the game. Armies
and/or heroes may search at temples, and receive a blessing. This adds one
to the strength of all blessed armies.

If a group containing a hero searches a temple, the hero may also be given the
option of a quest.

A group containing a hero may also search ruins, which can contain treasure,
artefacts or allies. These ruins are always defended (see Chapter 13).

(g). The View Menu

Army Bonus

This command lists all the army types in the game, with their strength, Move
and Combat bonuses.

ltems

This command explains the effects of the magic items in the current scenario.
Cities

This command takes you to the production dialog for your cities and selects
the City Info command (see Chapter 12).
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Build

This command takes you to the production dialog and selects the Building
command (see Chapter 12).

Production

This command takes you to the production dialog for your cities and selects
the Produce New Army command (see Chapter 12).

Vectoring

This command takes you to the production dialog for your cities and selects
the Vector command (see Chapter 12).

Ruins

This command brings up a dialog showing the location of every ruin and
temple, and shows whether each ruin has been explored (see Chapter 13).

Stack

If you have a currently selected stack, this command brings up a stack dialog.
It works in exactly the same way as the Stack Palette at the bottom of the screen
(see Chapter 7).

(h). The History Menu

Show History

This command brings up whichever of the history reports you last examined.
City

This dialog shows a graph of the number of cities you own, over time.

Events

This dialog shows the notable events that have occurred each turn. The arrow
keys or the slider can be used to scroll through each turn. Notable events
include the arrival or death of heroes, quests, the fall of cities and so on.

Gold

This dialog shows a graph of the gold levels of all players over time, and
reports your current gold total.

59



Winners

This dialog shows a graph of each side’s performance over time, and reports
the current leader.

Triumphs

This dialog shows the losses to your side, and the casualties you have inflicted
on the others. It opens showing your losses, in various categories, which you
hope will be minor. The shields of all sides are displayed at the top of the
dialog. Clicking on a shield will show the total casualties that you have caused
that side. In accordance with time honoured tradition, the language of the
report alters as appropriate.

(i). The Turn Menu

End Turn
Ends the turn.

Save and End Turn
Saves the game under the current save name, and ends the turn.

Hide Strategic Map Window
Hide Control Window

Hide Info Window

Clean Up Windows

Restores the windows to their default condition.

Game Settings

This dialog allows you to customise game settings. Players can be switched
between human and computer control. Please bear in mind that switching
between human and computer play will result in several turns of confusion for

the computer player while it sorts itself out.

Enhanced Production, which adds +2 to each army’s combat value, can be
turned on or off for each player. You can also choose whether you wish to
Observe each computer player’s turn in full.
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Sound Volumes
Sliders control the level of Music, Sound and Sound Effects.

Note. Quicktime can take a few seconds to set up and play a new piece of
music. While it is doing this, a cursor shaped like a musical note is displayed.

Shortcuts

This dialog lists all useful commands available from the Menu Bar in the game,
along with an icon for each one. There are four slots available for these large
buttons in the Action Palette. The currently selected commands are also listed
at the bottom of the Menu Shortcuts dialog.

These buttons give the player a quick way of executing the selected commands
without having to use the Menu Bar, or a key-press.

To choose the shortcuts you want, click on one the icons at the bottom of the
dialog, and then click on the icon of the command you wish to use. You cando
this for each button if you like. When you hit the Done button, the shortcuts in
the Action Palette will be changed to your selections.

17. SURRENDER

If you are doing very well, then the surviving computer players may offer to
surrender. This will happen if you own more than half the cities on the map,
and have a reasonable margin of cities controlled over the nearest computer
player. When surrender is offered, you have two options.

Oneistoaccept the surrender, and be proclaimed the winner. The other option
is to pop the petitioners’ heads on pikes, in which case the struggle continues
to the last city.

18. EROUBLE SHOQTLTING

Memory

The first thing to do is to check that you have enough memory to run Warlords
II. That is at least 4 Mb of installed RAM, with at least 2.5 Mb free before you
run the game. If you don’t have at least 4Mb installed, then you will not be able
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to run the game. If you do, your System and other software may still be taking
up too much memory.

Check under the About this Macintosh item in the Apple menu in the Finder.
[f the figure quoted for Largest Unused Block is not greater than 2.5 Mb, then
you will have to free up some more memory. You can do this by turning off
various Control Panels and System Extensions that are not needed.

256 Color Graphics

Warlords Il requires 256 color (or 256 grey scale) graphics to run. It cannot run
in 16 colors. It can run at higher color depths, but doing this will slow the game
down considerably, and the colors may not match those on 256 color screens.

System
If you aren’t running System 7 or greater, Warlords Il can’t run.

Speed

Running the game with minimum memory will definitely cause it to slow
down. If speed is a problem, try freeing up as much memory as possible.
Having more than 3 Mb free will definitely improve execution speed. Examine
the Read Me file for the latest on the exact memory requirements.

Also, running the game at color depths above 256 colors will also slow the
game down.

System Extension Conflicts

It is literally impossible to predict the interactions of the various System
Extensions, Control Panels and other software that users may be running on
their Macs. If something unexplained occurs, the first thing to do is to restart
the Mac with all System Extensions turned otf. You do this by holding down
the SHIFT key while rebooting your Mac.

(If you do turn off all System Extensions, you will turn off Quicktime, so that
when the game runs, the title sequence and the music won’t be able to play).

[f turning off all System Extensions cures the problem, then try turning them
back on by one to try and isolate which one is causing the problem.
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Try Another Mac

Sometimes things go wrong with floppy disks, or installations, or any one of
anumber of malign influences can get at your Mac. If it's possible, try installing
the program on another Mac, and see if the problem is duplicated on the new
Mac. This may help with diagnosis.

Reporting the Problem

This equation is very easy. The more you tell us about the problem, the easier
itis to help, and the quicker the solution. When you contact SSG, please, please
include the following information.

Your Computer Type - you know its a Mac, but do we? We constantly get
messages of the type ‘Program X crashes my computer. Help!". Since there are
now DOS and Mac versions of Warlords 11, a message like that above is useless.

More About Your Computer Type - we’d like to know the model, the amount of
installed RAM, the Largest Unused Block just before running Warlords II, and
the version number of the System you are running. If you're using a Power
Mac, are you running the native or the 680x0 version; if you're running a
graphics card other than the standard Apple hardware, please let us know.
Include anything else that might be out of the ordinary.

Error Messages

Please write down any error messages, and quote them fully when reporting
the problem. These are the best way of diagnosing problems, so it doesn’t
make sense to leave information out.

General Description and Repeatability

Please include a detailed description, plusany ideas you have about how often
the problem occurs, whether it's easily repeatable and if it seems to be
triggered by anything in particular. If you create a save game which duplicates
the problem, this may be a big help in fixing the problem. You don’t have to
send us the save game straight away, but do let us know if you have one.

The addresses for contacting SSG customer support are listed in the next
section.
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19. ADDRESSES

Compuserve: 72662,3471
Genie: S5G
AppleLink: AUST0161

ON-LINE SUPPORT VIA COMPUSERVE

For on-line support of Warlords Il via Compuserve, call toll-free on 1-800-524-
3388 and ask for Representative #574 to get your free introductory member-
ship and $15.00 usage credit.

Ifyou arealready a member of Compuserve, type thecommand GOGAMDPUB
at any ! prompt to reach SSG’s support section (Section 4), or contact our
technical support department on 72662,3471.
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APPENDIX A

Answers to commonly asked questions.

You havea 1insix chance in any one turn of getting a Hero, if you have enough
money. Nothing in the game modifies this chance. The actual amount you
need varies, but 1500 GP should always be enough.

Bonuses for stacks are calculated before combat, and the death of a unit
conferring a bonus during a combat does not remove that bonus.

Yes, units can disappear. If the computer gets a stack into a position where it
just doesn’t know what to do with it, it may well disband it. Don’t panic if this

happens.

APPENDIX B

Here is a detailed explanation of combat written by Roger Keating. Are you
sure you want to know this?

Before describing how combat works in Warlords II, I will first describe the
combat mechanics. | will then pass on some tactical advice.

When a combat is initiated in Warlords 1, all attacking armies in the currently
selected group are moved on to the defending armies. At the end of the combat
there will only be the victors standing. The terrain for the combat will be the
terrain the attacking armies move to.

If a city is being attacked, all enemy armies in the city are called to defend it.
If the attack is outside the city, then only those enemy armies in the grid will
defend. If the attack is to take place over water, shore or mountain terrain and
a hero is present, a flying unit may be promoted to the right most position, so
that the flying unit fights last. Otherwise the hero might survive the fight only
to be stranded because he can no longer traverse the terrain without a flying
unit.

Hit Points

All the armies are given 2 hit points before a combat is conducted. They must
each take 2 hits before they are destroyed. This means that once a combat is
finished, any wounded units are automatically healed.
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Group Bonuses for Armies

Terrain is classified as CITY, WOODS, HILLS or OPEN (which includes water,
shore, mountains etc.).

SIEGE: Catapult
NEGATE HERO: Archon
NEGATE NON HERO: Devil

MAX TERRAIN: Wolf Riders (+1 hills), Dragon (+2 all), Wizard, Worm,
Undead, Demon, Elemental, Devil, Archon, Unicorn, Pegasi (+1 all)

MAX SUBTRACT : Elephant (-1 to all enemy armies)

Note that with the MAX bonuses only the highest bonus is used so that if there
are 2 elephants in a stack they will only give a bonus of (-1).

Attack Bonuses

Now all the attacking bonuses are calculated . All the attacking armies are
examined and the following bonuses allocated;

MAX HERO STRENGTH: calculate (with battle items) the highest hero
strength

ATTACK SIEGE: if true will negate DEFEND FORTIFIED

ATTACK NEGATE HERQO: if true will negate DEFEND HERO BONUS
ATTACK NEGATE NON HERQO: if true will negate DEFEND MAX TERRAIN
ATTACK MAX TERRAIN: the highest bonus for this terrain is calculated
ATTACK COMMAND: sum all command items carried by heroes
ATTACK MAX SUBTRACT: the highest negative bonus is calculated

After all armies have gone through this procedure then calculate ATTACK
HERO BONUS: Using the MAX HERO STRENGTH give a bonus of 3 if hero
strength is 9, 2 if the strength is greater than 6 and 1 if the strength is greater

than 3.

Defend Bonuses

Now carry out the above procedure for the defending armies plus; DEFEND
FORTIFIED: if the group was in a tower or a city
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Modify DEFEND FORTIFIED bonus. If the attackers have a siege engine then
DEFEND FORTIFIED is negated. If the defenders are in a tower then DEFEND
FORTIFIED = 1, on a special location DEFEND FORTIFIED = 2 or in a city
DEFEND FORTIFIED = 1 if the city produces less than 3 armies and 2 if the

city produces 3 or 4 armies.
These bonuses are halved if it is a neutral city that is attacked.

Calculate the ATTACK MODIFIER
The ATTACK MODIFIER is calculated as follows;

ATTACK HERO BONUS (if no DEFEND NEGATE HERO ) + ATTACK MAX
TERRAIN ( if no DEFEND NEGATE NON HERO )

The ATTACK MODIFIER at this point can be no larger than 5 (although this
may be modified in future scenarios). The ATTACK MODIFIER is then
reduced by the DEFEND MAX SUBTRACT value.

Calculate the DEFEND MODIFIER

As above plus + DEFEND FORTIFIED ( if attackers do not have a siege engine
- see above)

Individual Bonuses for armies (using the Default Army Set as an example)
Defensive terrain is classified as CITY, WOODS, HILLS or OPEN (which

includes water, shore, mountains etc.).

CITY: Minotaurs (+1) Spiders (+2) Griffins (+2)

WOODS: Archers (+1)

HILLS: Dwarfs (+1)

OPEN: Light Cav. (+1) Pikemen (+1) Heavy Cav. (+2)

Individual bonuses areadded to army strengths and cannot be negated by any
special ability.

Calculate the Attacking Armies' Strengths

If attacking armies are in boats their strengths are always 4.

Attacking armies strengths are increased by the ATTACK MODIFIER.
Heroes will have battle items added to their strengths.

Individual bonuses are added to armies depending on terrain (see above).
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Armies can never exceed a strength of 15.

Calculate the Defending Armies’ Strengths
The defenders then go through the same procedure

Working Out the Results

The attackers and defenders are formed into two lines facing each other in the
order dictated by the ‘fight order’ dialog. Starting with armies to the left, the
attacking and defending units each throw one dice. Normally a 20 sided die is
used although if the Intense Combat is chosen, a 24 sided die is used.

If the attacking army throws its modified strength or less and the defender
throws more than his modified strength the attacking player scores one hit. If
the defending army throws his strength or less and the attacking army throws
more, the defender scores one hit. If neither player scores, they continue to
throw until one army is destroyed. If 10000 throws are made without a hit
being scored the defender automatically wins and the attacking army is
destroyed. If the winning army has taken a hit in one round of individual
combat then it will need only 1 more hit to destroy him.

[t may help to consider the combat procedure between armies with a worked

example. Consider a Dragon, final strength of 11, attacking a Light Infantry
(LI), strength 2. If the Dragon rolls 11 or less, and the LI rolls 3 or more, then

the Dragon hits the LI. This outcome is reasonably likely.

If the LI throws 2 or less, and the Dragon throws 12 or more, then the LI gets
a hit on the Dragon. This is less likely, but by no means impossible.

Some Principles in Combats

1. Anattack can be thought of as one more combats between individual armies.
If you havea group of weak armies attacking a strong army, it is better to group
them together and conduct one attack, rather than make a series of individual
attacks. This is because surviving armies are healed at the end of each attack,
not at the end of each combat. Attacking as a single group gives the defender
no chance to heal, (unless it defeats all of the attackers).

2. As the normal dice throw is a 20 and the maximum strength is 15, a group
of small armies can defeat the strongest single army.
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3. It is wise to put siege engines and elephants well up the fight order index,
so that they fight as late in the combat as possible. You want to preserve them

for future combats because their bonuses can devastate an enemy.

4. The adviser carries out 20 combats using the normal combat routines and
reports back how many times the attack was made successfully. This means
that combats between small groups of armies will produce diverse results but
with a large number of armies the results will be more consistent.

5. High class armies (specials etc.) are good at fighting but it is often useful to
use them with armies that are easier to replace. Remember that the toughest
army can be defeated.

6. Armies at sea are easily ambushed by fliers as their modified strength can
only be 4. Scouts are useful at sea as they fight better but naval units have a
higher maintenance cost and are an expensive way to protect sea lanes.

7.Siege engines are useful but they do take time to make. It is best to wait until
you have a good number of cities before building them.

8. Itis often better to wait for a hero to come along before waging a war. A war
of attrition is a costly war. A hero with a (+3) bonus gets the job done a lot
quicker and at the cost of a lot less armies.

9. Taking an opponent’s city because it is weakly defended can sometimes be
the wrong thing to do if you haven’t the force to defend it against a counter-
attack. Make sure that you have the force necessary to protect your new cities
and to take advantage of any opening that may come your way.

10. As you can see from the combat rules above, all bonuses are calculated

before an attack takes place. The death during an attack of units conferring
bonuses has no affect on the final strengths for that combat.

A Last Word on Statistics

[tis in the nature of humanity to expect average results, and to hope for more.

It is in the nature of the universe to deliver all types of results. A moment’s
thought about the vast number of combat calculations made during the course

of a game of Warlords IT will reveal that a number of below average results will
occur. Your best stacks will suffer unexpected reverses.

It's no use blaming the Combat Adviser, or the programmers when this
happens. A true gamer both expects and overcomes adversity.
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